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Qu’est-ce qu’Impress?

Impress est le programme de présentation de diaporamas fourni  par LibreOffice. Vous pouvez 
créer  des  diapositives  qui  contiennent  de  nombreux  types  d’éléments,  du  texte,  des  listes 
numérotées, tableaux, diagrammes et une large gamme d’objets graphiques comme des cliparts, 
des dessins ou des photographies. Impress accède également aux outils linguistiques de la suite 
bureautique (orthographe, synonymes, césure, grammaire...),  des styles de texte, et des styles 
d’arrière-plan. Enfin vous pourrez rendre vos présentations dynamiques en utilisant des effets de 
transition entre les diapositives ou des animations des objets.

Ce chapitre contient les instructions, captures d’écrans et astuces qui vous guideront à travers 
l’environnement d’Impress pour créer vos propres présentations. Des techniques plus complexes 
sont mentionnées dans ce chapitre, les explications pour les maîtriser se trouvent dans le Guide 
Impress. Si vous savez déjà créer des présentations et diapositives, nous vous recommandons la 
lecture du Guide Impress.

L’utilisation d’Impress, au-delà de très simples diaporamas, requiert la connaissance des éléments 
contenus dans les diapositives. Le texte des diapositives utilise des styles pour déterminer son 
apparence. Créer des dessins avec Impress est semblable à ce qui se fait avec  le  programme 
Draw de la suite LibreOffice. Pour cela, nous vous recommandons de lire également le Chapitre 3,  
Utiliser les Styles et Modèles, et le Chapitre 7, Débuter avec Draw. Vous pourriez aussi consulter 
le Guide Draw pour plus de détails sur la façon d’utiliser les outils de dessin.

Démarrer le programme Impress

Vous pouvez lancer le programme de différentes façons

• À partir du centre de démarrage LibreOffice, si aucun composant n’est déjà démarré.

• À partir du menu système, le menu standard qui vous sert à lancer tous vos programmes. Le 
menu Démarrer de Windows, le menu Applications de Gnome, le menu KDE identifiable par 
son logo sous KDE, sous Mac OS X on parle du menu Applications, enfin sous Ubuntu il s’agit 
du Lanceur.

• Sous Windows utilisez l’icône :  Présentation, dans le Démarrage rapide de LibreOffice. Des 
fonctions similaires existent pour Mac et Linux ; voir Chapitre 1, Introduction à LibreOffice.

• À partir de n’importe quel module, cliquez sur le triangle à droite de l’icône Nouveau, sur la 
barre d’outils  principale et sélectionnez  Présentation dans la liste déroulante ou choisissez 
Fichier > Nouveau > Présentation dans la barre des menus.

• En ligne de commande, tapez : soffice --impress puis validez.

Note

Lorsque  LibreOffice  a  été  installé  sur  votre  machine,  en  principe,  un  item  de 
démarrage a été créé pour chaque composant au sein de votre menu système. Le 
nom  et  l’emplacement  exacts  de  ces  items  dépendent  de  votre  système 
d’exploitation et de son interface graphique.

Quand vous lancez  Impress  pour  la  première  fois,  l’Assistant  de  Présentation  apparaît.  Vous 
pouvez alors choisir parmi les options suivantes :

• Présentation vierge, vous donne un nouveau document vide

• À partir du modèle, affiche une présentation formatée selon le modèle de votre choix

• Ouvrir une présentation existante

• Cliquez sur Créer pour afficher la fenêtre principale d’Impress.

Pour les instructions détaillées sur l’utilisation de l’Assistant Présentation, voir la section Créer une
nouvelle présentation page 13.

Démarrer le programme Impress 5



La fenêtre principale d’Impress

La fenêtre principale Impress (Figure 1) se divise en trois parties : le volet  Diapos,  l’espace de 
travail et  le  volet  Tâches.  Des  barres  d’outils  supplémentaires  peuvent  apparaître  pendant  la 
création de la présentation.

Figure 1 : Fenêtre principale Impress avec ses trois volets

Note

L’apparence des boutons dépend du style des icônes choisi (Outils > Options > 
LibreOffice  >  Affichage).  Le  système  d’exploitation  peut  également  modifier 
l’apparence des fenêtres. Ainsi votre écran peut ne pas correspondre exactement 
aux représentations.

Astuce

Vous pouvez fermer les volets Diapos ou Tâches en cliquant sur la croix (X) dans le 
coin supérieur droit  du volet ou par le biais du menu  Affichage > Volet Diapo / 
Volet Tâches

Vous pouvez aussi  augmenter  l’espace de travail  en cliquant  sur  les marqueurs 
placés au milieu de la ligne de séparation verticale des volets (indiqués Figure 1). 
L’utilisation  des  marqueurs  Afficher/Masquer  vous  permet  de  réduire/agrandir 
chaque volet par le biais d’un cliquer-glisser.

Volet Diapos
Le  volet Diapos contient des vignettes représentant les diapositives de votre présentation, dans 
l’ordre où elles apparaîtront à moins que vous ne modifiiez l’ordre du diaporama. Cliquer sur une 
vignette dans le volet Diapos sélectionne la diapositive et la place dans l’espace de travail. Quand 
une diapositive se trouve dans l’espace de travail, vous pouvez la modifier à loisir.
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En  survolant  chaque  diapositive,  trois  icônes  sur  fond  noir  apparaissent  (Figure  2).  Elles 
permettent (de gauche à droite) :

• Démarrer le diaporama à partir de cette diapo ;

• Masquer la diapo pour qu’elle n’apparaisse pas dans le diaporama ;

• Dupliquer la diapo.

Figure 2 : Boutons rapides

D’autres opérations accessibles par clic-droit peuvent s’effectuer sur une ou plusieurs diapositives 
simultanément à partir du volet Diapos :

• Ajouter de nouvelles diapositives.

• Supprimer une diapositive, si vous n’en avez plus besoin.

• Renommer une diapositive.

• Copier ou déplacer une diapositive par cliquer-glisser.

Volet Tâches
Le volet Tâches comporte cinq sections. Pour développer la section que vous souhaitez utiliser, 
cliquez sur le titre de la section. Une seule section à la fois peut s’afficher.

Pages maîtresses
Ici  vous  définissez  le  style  de  page  (diapositive)  pour  votre  présentation.  Impress  inclus 
plusieurs modèles de pages maîtresses. L’un d’eux (défaut) est vierge et les autres ont des 
arrière-plans et styles de texte.

Astuce
Appuyez sur F11 pour ouvrir la fenêtre Styles et formatage, où vous pouvez modifier 
les styles utilisés dans chaque page maîtresse selon vos goûts à n’importe quel 
moment.

Mises en page
Les mises en page proposées par Impress apparaissent ici. Elles organisent le nombre et la 
position des objets par défaut. Vous pouvez choisir celle qui vous convient, l’utiliser comme elle 
est  ou  la  modifier.  Vous  ne  pouvez  cependant  pas  sauvegarder  des  mises  en  page 
personnalisées.

Ébauche de tableau
Les styles de tableau sont  proposés dans cette section.  Vous pouvez de plus en changer 
l’apparence  grâce  aux  options  qui  permettent  d’afficher/masquer  des  colonnes  et  lignes 
spécifiques du tableau.
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Animation personnalisée
De nombreuses animations sont disponibles pour mettre en évidence les différents éléments 
de chaque diapositive. La section Animation personnalisée, propose un moyen facile d’ajouter, 
modifier, ou supprimer les animations.

Transition
La section Transition s’applique aux diapositives ; elle donne accès à de nombreuses options 
de transition. Par défaut, le réglage est Aucune transition, et la diapositive suivante remplace 
simplement la précédente. Cependant vous pouvez choisir un effet de transition, la vitesse de 
transition  (lent,  moyen,  rapide),  le  mode  de  transition  (manuel,  automatique)  et  le  temps 
d’affichage de la diapositive (transition automatique seulement).

L’espace de travail
L’espace  de  travail  (au  centre)  propose  cinq  onglets :  Normal,  Plan,  Notes, Prospectus,  et 
Trieuse de diapositives (Figure 3). Les cinq onglets abritent des vues spécifiques, l’espace de 
travail  change  d’aspect  en  fonction  de  la  vue  (l’onglet)  que  vous  avez  choisie.  Les  vues  de 
l’espace de travail sont décrites en détail en page 10.

Figure 3 : Les onglets de l’espace de travail

Les barres d’outils
De nombreuses barres d’outils sont à votre disposition lors de la création d’une diapositive ; vous 
pouvez les afficher ou les masquer grâce au sous-menu Affichage > Barres d’outils.

Vous pouvez également choisir les outils que vous souhaitez faire apparaître dans chaque barre 
d’outils ; voir le Chapitre 1, Introduction à LibreOffice.

Certaines barres d’outils d’Impress sont identiques à celles de Draw. Référez-vous au Guide de 
Draw pour des informations détaillées sur leur fonction et usage.

La barre d’état
La barre d’état, située sur le bord inférieur de la fenêtre Impress, contient des informations utiles 
en cours de travail, sur l’état de l’application, de l’objet sélectionné et du document. Pour plus de 
détails voir Chapitre 1, Introduction à LibreOffice de ce guide et Chapitre 1, Introduction à Impress 
dans le Guide d’Impress.

Note
Position et Taille sont donnés dans l’unité définie par le menu Outil > Options > 
LibreOffice Impress > Général.

Informations sur l’objet Position Taille

Modifications non
enregistrées

Signature
numérique N° diapo

Curseur
de zoom

Valeur
du zoomMasque /

Page maîtresse

Figure 4 : Barre d’état
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De gauche à droite :

• Information sur l’objet : varie en fonction de la sélection, par exemple :

Exemple de sélection Information affichée

Cadre de texte Édition texte : Paragraphe 1, Ligne 1, colonne 1

Diagramme, feuille de 
calcul

Objet incorporé (OLE) « nom de l’objet » 
sélectionné

Image Bitmap sélectionné

• Position et Taille : La position du curseur ou du coin supérieur gauche de l’objet sélectionné ; 
suivi par la largeur et la hauteur de l’objet.

• Modifications  non  enregistrées :  Ce  drapeau  indique  si  le  document  a  besoin  d’être 
sauvegardé. Un double-clic dessus affiche la boîte de dialogue de sauvegarde.

• Signature numérique : Ce drapeau indique si le document présente une signature numérique. 
Après  avoir  enregistré  le  fichier,  un  double-clic  à  cet  endroit  ouvre  la  boîte de  dialogue 
signature numérique.

• N°  diapo :  Affiche  le  numéro  de  la  diapositive  et  le  nombre  de  diapositives dans  la 
présentation.

• Masque/Page maîtresse : Le masque (page maîtresse) associé à la diapositive, un double-
clic provoque l’affichage de la fenêtre des styles de diapo.

• Curseur de zoom : Ajuste le zoom de l’espace de travail.

• Valeur du zoom : Affiche la valeur du zoom en pourcentage, un double-clic vous permet de 
modifier la valeur.

Vous pouvez masquer la barre d’état par le menu Affichage > Barre d’état.

Le navigateur
Le navigateur affiche tous les objets contenus dans le 
document.  C’est  un  autre  moyen  pratique  de  se 
déplacer  dans  un  document  et  de  retrouver  les 
différents  objets  à  l’intérieur.  Pour  afficher  le 
Navigateur, utilisez son icône  dans la barre d’outils 

standard,  ou  choisissez  Affichage  >  Navigateur  > 
dans  la  barre  des  menus  ou  bien  encore  la 
combinaison de touches Ctrl+Maj+F5.

Le  Navigateur  est  plus  utile  si  vous  nommez  vos 
diapositives  et  objets  (images,  feuilles  de  calculs...). 
Des  noms  représentatifs,  mieux  que  les  noms  par 
défaut  (image  1,  texte1...),  vous  permettront  de 
localiser vos éléments rapidement.
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Les vues de l’espace de travail

Chaque vue, sélectionnable par les onglets de la Figure 3, est conçue pour faciliter la réalisation 
de certaines tâches ; il est préférable de vous familiariser avec chacune des vues pour pouvoir 
rapidement accomplir chaque tâche par la suite.

Note
Chaque vue affiche un jeu différent de barres d’outils quand vous l’avez activée. 
Vous pouvez cependant utiliser le menu Affichage > Barres d’outils.

Normal
La vue  Normal est  la  vue principale  et  permet  de  travailler  avec une diapositive  déterminée. 
Utilisez cette vue pour effectuer la mise en page, dessiner, ajouter du texte, des images et des 
effets d’animation.

Pour afficher une diapositive dans l’espace de travail  (vue Normal)  (Figure  1),  sélectionnez la 
vignette  de la  diapositive  dans le  volet  Diapos ou  faites  un double-clic  sur  son  nom dans le 
Navigateur (page 9).

Plan
La vue Plan contient toutes les diapositives de la présentation dans l’ordre. Cette vue présente les 
titres et  les  listes de chaque diapositive sous forme de plan.  Seul  le  contenu du cadre texte 
principal de chaque diapositive s’affiche, donc si votre diapositive inclut d’autres cadres texte ou 
d’autres types de cadre, les textes qu’ils contiennent n’apparaîtront pas. Le nom des diapositives 
ne s’affichera pas non plus.

Figure 6 : Vue Plan

Utilisez la vue Plan pour :

1) Modifier le texte d’une diapositive :

• Ajouter et supprimer du texte simplement.

• Déplacer les paragraphes de texte dans une diapositive vers le haut ou vers le bas 
en utilisant les flèches sur la barre d’outils Formatage du texte (voir Figure 7).

• Changer de niveau dans le plan pour chaque paragraphe en utilisant les flèches 
(droite, gauche) de la barre d’outils Formatage du texte.

2) Ajouter directement une diapositive sans revenir à la vue Normal, par un retour à la ligne.

Figure 7 : Barre d’outils Formatage du texte
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Notes
Utilisez la vue Notes (Figure 8) pour ajouter des notes à une diapositive. Ces notes ne s’affichent 
pas lors  de la  présentation du Diaporama,  mais peuvent  être utiles pour préparer le  discours 
accompagnant la présentation.

Figure 8 : Vue Notes

3) Sélectionnez l’onglet Notes dans l’espace de travail.

4) Sélectionnez la diapositive pour laquelle vous voulez joindre des notes :

• Cliquez sur la diapositive dans le volet Diapos.

• Double-cliquez sur le nom de la diapositive au moyen du navigateur.

5) Dans la fenêtre Figure 8, utilisez le cadre inférieur « Cliquez pour ajouter des notes » pour 
saisir vos annotations.

Vous  pouvez  redimensionner  le  cadre  des  notes  en  utilisant  les  poignées  de  couleur  qui 
apparaissent  quand vous cliquez sur  la  bordure du cadre.  Vous pouvez aussi  le  déplacer  en 
pointant sur la bordure puis cliquer-glisser. Pour changer le style du texte modifiez le style Notes 
(F11 pour afficher la fenêtre des styles).

Prospectus
La  vue Prospectus  permet  la  mise  en  page  des  diapositives  dans  l’objectif  d’imprimer  le 
diaporama. Affichez la vue Prospectus dans l’espace de travail, puis sélectionnez Mises en page 
dans le volet Tâches. Vous pouvez choisir d’imprimer 1,2,3,4,6 ou 9 diapositive(s) par page.

Figure 9 : Panneau Mises en page
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Utilisez cette vue pour personnaliser les informations imprimées sur le prospectus. Référez-vous 
au Chapitre 10, Imprimez, envoyez, et sauvegardez des diaporamas du Guide Impress pour plus 
d’instructions concernant l’impression de diapos, prospectus et notes.

Trieuse de diapositives
La vue Trieuse de diapositives (Figure 10) affiche toutes les diapositives sous forme de vignettes. 
Vous pouvez sélectionner une diapositive ou un groupe de diapositives.

Figure 10 : Vue Trieuse de diapositives

Personnaliser la vue Trieuse de diapositives
Pour modifier le nombres de diapositives par ligne :

1) Sélectionnez Affichage > Barre d’outils > Trieuse de diapositives et Mode Diapo pour 
afficher ou masquer les deux barres d’outils de la Figure 11.

2) Ajustez le nombre de diapositives par ligne, entre 1 et 15.

Figure 11 : Barre d’outils Trieuse de diapositives

Déplacer une diapositive par le biais de la trieuse
Pour déplacer une diapositive dans la présentation en utilisant la trieuse :

1) Cliquez sur la diapositive, qui apparaît alors en surbrillance (voir Figure 10).

2) Cliquez-glissez la diapositive à son nouvel emplacement.

Sélectionner et déplacer des groupes de diapositives
Pour sélectionner un groupe de diapositives, utilisez l’une de ces méthodes :

• Utilisez la touche (Ctrl) : Cliquez sur la première diapositive ; tout en maintenant appuyée la 
touche Ctrl sélectionnez les autres diapositives du groupe.
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• Utilisez la touche (Maj) : Cliquez sur la première diapositive, puis appuyez sur la touche Maj et 
cliquez sur la dernière diapositive du groupe. Cette méthode sélectionne toutes les diapositives 
entre  la  première  et  la  dernière  désignée ;  cette  méthode  est  utile  pour  sélectionner  des 
éléments contigus.

• Utilisez la souris : Cliquez sur le côté extérieur de la première diapositive que vous souhaitez 
sélectionner  puis  glissez  la  souris  pour  inclure  les  autres  diapositives  jusqu’à  ce  qu’elles 
apparaissent en surbrillance.

Pour déplacer un groupe de diapositives :

1) Sélectionnez le groupe de diapositives.

2) Cliquez-glissez le groupe vers sa nouvelle destination.

Travailler dans la vue Trieuse de diapositives
Vous pouvez travailler sur les diapositives dans la vue trieuse de diapositives de la même façon 
que dans le volet Diapos de la vue Normal.

Pour faire des modifications, cliquez avec le bouton droit et choisissez une commande dans le 
menu contextuel qui s’affiche :

• Nouvelle diapo : ajoute une diapositive après celle qui est sélectionnée.

• Supprimer la diapo : détruit la diapositive sélectionnée.

• Renommer la diapo : change le nom de la diapositive active.

• Mise en page des diapos : affiche le panneau Mises en page dans le volet Tâches.

• Transition :  vous  permet  de  déterminer  les  effets  de  transitions  de  la/des  diapositive(s) 
sélectionnée(s).

• Masquer la diapo : les diapositives masquées ne s’affichent pas lors de la présentation.

• Couper : supprime la diapositive sélectionnée et la copie dans le presse-papier.

• Copier : copie la diapositive dans le presse-papier.

• Coller : insère la diapositive contenue dans le presse-papier 

Créer une nouvelle présentation

Cette section décrit comment commencer une nouvelle présentation avec l’Assistant présentation.

Note

Si vous préférez ne pas utiliser l’Assistant Présentation, vous pouvez sélectionner 
Ne plus afficher cet Assistant. Vous pourrez activer de nouveau son apparition 
automatique plus tard via Outils > Options > LibreOffice Impress > Général > 
Nouveau Document et cochez l’option : Démarrer avec l’assistant.

Astuce

La première chose est de définir les objectifs et le plan de la présentation. Même si 
vous pouvez effectuer les changements au fil de vos idées, vous gagnerez 
beaucoup de temps en définissant au départ votre auditoire, la structure, le contenu 
de la présentation et la manière dont elle sera diffusée...
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Quand vous démarrez Impress, l’Assistant Présentation s’affiche (Figure 13).

Figure 12 : Choisir le type de présentation

1) Sous Type, choisissez une option. Les trois options suivantes sont traitées dans le Guide 
Impress.

• Présentation vierge crée une présentation vide.

• À  partir  du  modèle utilise  un  modèle  existant  comme  base  de  votre  nouvelle 
présentation.  L’assistant  poursuit  en  vous  proposant  une  liste  de  modèles 
disponibles. Choisissez celui qui vous convient.

• Ouvrir une présentation existante pour continuer à travailler sur une présentation 
créée au préalable. L’assistant vous montre une liste de présentations existantes. 
Choisissez celle que vous voulez.

2) Cliquer  sur  Suivant affiche  l’étape  2  de  l’Assistant  présentation ;  ci-dessous  tel  qu’il 
apparaît si vous avez sélectionné  Présentation vierge à l’étape 1. Si vous avez choisi  À 
partir du modèle, un exemple de style de page s’affiche dans la fenêtre aperçu.

Figure 13 : Sélectionner un style de page
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3) Choisissez  un  style  de  page dans  la  liste.  La  section  style  de  page propose  deux 
catégories  Arrière-plans de présentation et  Présentations. Chacune affiche une liste de 
choix.

La catégorie Arrière-plans de présentation apparaît  Figure 13. En choisissant un élément 
vous visualisez un aperçu dans la partie droite de la fenêtre. Impress propose par défaut 
trois choix dans la catégorie Présentations : <Original>, Présentation d’un nouveau produit,  
Présentation de stratégie :

• <Original> pour une présentation blanche, sans style de page.

• Présentation d’un nouveau produit et Présentation de stratégie ont leur propre style 
de page qui s’affiche dans la partie droite de la fenêtre

Note
Présentation d’un nouveau produit et Présentation de stratégie sont des modèles de 
présentation intégrés. Vous pouvez les utiliser en choisissant  À partir du modèle 
lors de la première étape (Figure 13).

4) Définissez comment la présentation sera utilisée sous Sélectionner un média de sortie. 
Le plus souvent pour l’affichage sur un écran d’ordinateur, choisissez Écran. Vous pourrez 
modifier le format de page à n’importe quel moment.

Note
Le média de sortie Écran est optimisé pour un affichage 4:3 (28cm x 21cm) cela ne 
convient  pas  aux  écrans  larges  modernes.  Vous  pouvez  changer  de  taille  de 
diapositive à n’importe quel moment via la vue Normal et le menu Format > Page.

5) Cliquez sur Suivant. L’étape 3 de l’Assistant présentation apparaît (Figure 14).

• Choisissez  l’effet  de  transition  de  diapo  que  vous  souhaitez  à  partir  du  menu 
déroulant.

• Sélectionnez la vitesse d’exécution de l’effet de transition depuis le menu déroulant 
Vitesse. Moyen est un bon choix par défaut.

6) Cliquez sur Créer. Une nouvelle présentation est créée.

Figure 14 : Sélectionner un effet de transition pour les diapositives
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Astuce

Vous pouvez accepter les valeurs par défaut pour  Effet et  Vitesse jusqu’à ce que 
vous soyez habitué à la création de présentations. Vous pouvez changer ces valeurs 
plus tard en travaillant sur  transition dans le volet Tâches. Ces deux notions sont 
expliquées plus en détail dans le Chapitre 9 Diaporamas du Guide Impress.

Note
Si vous avez sélectionné À partir du modèle lors de l’étape 1, le bouton Suivant sera 
actif  à  l’étape  3  et  d’autres  étapes  seront  disponibles.  Ces  étapes  ne  sont  pas 
décrites ici.

Attention

Assurez-vous de sauvegarder régulièrement votre travail, pour prévenir toute perte 
de données si quelque chose d’imprévu se produit. Vous pouvez activer la fonction 
d’enregistrement automatique (Outils > Options > Chargement/enregistrement . 
Général).  Vérifiez  que  Enregistrer  les  informations  de  récupération 
automatique  toutes  les est  activé  et  que  la  fréquence  d’enregistrement  est 
renseignée.  Cette  option  n’enregistre  pas  la  présentation,  mais  permet  de  la 
récupérer dans un état proche du moment où LibreOffice s’est arrêté de manière 
imprévue.

Mettre en forme une présentation

Une  nouvelle  présentation  contient  seulement  une  diapositive  vide.  Dans  cette  section  nous 
commencerons par ajouter de nouvelles diapositives puis nous les adapterons à nos besoins.

Insérer une diapositive
Vous pouvez faire cela de différentes façons :

• Insertion > Diapo.

• Clic-droit sur la diapositive et Diapo > Nouvelle diapo dans le menu contextuel.

• Cliquez sur le bouton Diapo dans la barre d’outils Présentation (la liste déroulante à droite 

propose une liste de mise en page prédéfinie)  

Parfois plutôt  que de travailler  à partir  d’une nouvelle  diapositive,  vous voudrez dupliquer une 
diapositive existante. Dans ce cas sélectionnez la diapositive dans le volet Diapos, et cliquez sur le 
troisième bouton le plus à droite en bas de la diapo lorsque la souris la survole (Figure 2).

Sélectionner une mise en page
Dans le volet  Tâches, sélectionnez le panneau  Mises en page pour afficher les mises en page 
disponibles (Figure 15). Les modèles de mise en page proposent un nombre varié d’éléments, à 
partir d’une diapo vierge jusqu’à une diapositive pouvant contenir six cadres plus le titre.
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Figure 15 : Mises en page disponibles

La première page d’une présentation est généralement une page de titre. Diapo-titre (qui contient 
aussi  un cadre pour  un sous titre)  où  Titre,  contenu sont  des  modèles  de mise en page qui 
conviennent  pour  la  première  diapositive  de  la  présentation ;  d’ailleurs  pour  la  plupart  des 
diapositives vous utiliserez probablement la mise en page Titre, contenu.

Pour créer le titre, cliquez sur  Cliquez pour ajouter un titre (dans la mesure où vous n’avez pas 
choisi la mise en page vierge) et saisissez le texte du titre. Pour ajuster la mise en forme du titre, 
modifiez le style de Titre de la présentation ; voir Chapitre 2 Utiliser des pages maîtresses, styles  
et modèles du Guide Impress.

Si vous utilisez le modèle de mise en page Diapo-titre, cliquez sur Cliquez pour ajouter un texte 
pour ajouter un sous-titre. Procédez comme ci-dessus pour faire des ajustements sur la mise en 
forme, si nécessaire modifiez le style Sous-titre de la présentation également.

Note

Vous pouvez modifier  le texte et  les  objets  graphiques à n’importe quel  moment, 
pendant la préparation d’une présentation mais changer la mise en page d’une diapo 
dont le contenu est déjà fixé peut avoir des effets dramatiques. Choisissez la mise en 
page de votre diapositive avec la plus grande attention. Si vous devez changer de 
mise en page après avoir ajouté le contenu de la diapositive, vous n’en perdrez pas le 
contenu mais il vous faudra probablement refaire la mise en forme.

Astuce

Pour voir le nom des modèles de mise en page inclus, utilisez la fonction infobulle : 
positionnez le curseur de la souris sur un modèle dans le panneau Mises en page 
du volet Tâches et son nom s’affichera dans un petit rectangle.

Si infobulle n’est pas disponible, sélectionnez Outils > Options > LibreOffice > 
Général > Aide et cochez la case Infobulle. Si vous activez également la case 
Infoballon vous aurez des informations plus détaillées dans la bulle mais le nom de 
l’objet lui-même ne s’affichera plus.

Pour attribuer une mise en page, affichez la diapositive dans l’espace de travail et sélectionnez la 
mise en page désirée à partir du panneau Mise en page du volet Tâches.

Plusieurs modèles de mise en page contiennent un ou plusieurs  cadres-objets. Chacun de ces 
cadres peuvent contenir l’un ou l’autre des éléments suivants : Texte, Vidéo, Image, Diagramme 
ou Tableau.
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Vous pouvez choisir  le type de contenu en cliquant sur l’icône correspondante qui s’affiche au 
milieu du cadre-objet comme montré sur la Figure 16. Si vous souhaitez utiliser le cadre-objet pour 
saisir du texte, cliquez simplement n’importe où dans le cadre pour obtenir le curseur.

Figure 16 : Sélectionner le contenu du cadre-objet

Si vous avez choisi une mise en page avec un ou plusieurs cadre-objet, c’est le bon moment pour 
décider ce vous allez insérer dans chacun.

Modifier les éléments de la diapositive
À cette étape, la diapositive contient des éléments qui ont été inclus via la page maîtresse, mais 
aussi à travers le modèle de mise en page. Les modèles prédéfinis ne suffiront pas à vos besoins : 
vous voudrez supprimer des éléments inutiles et insérer de nouveaux objets comme du texte ou 
des images.

Quoiqu’Impress n’offre pas la fonctionnalité de créer de nouveaux modèles de mise en page, il 
vous autorise à redimensionner et déplacer les éléments de la mise en page. Il est aussi possible 
d’ajouter des éléments à la diapositive sans être limité par la taille ou la position des cadres-objets.

Pour  redimensionner  un  cadre-objet,  cliquez  sur  le  bord  du  cadre ;  8  poignées  de  couleur 
apparaissent. Placez le curseur sur une de ces poignées, le curseur prend l’aspect d’une double 
flèche. Vous pouvez alors cliquer-glisser et le cadre change de dimensions. 

Pour déplacer le cadre, éloignez la souris des poignées tout en restant sur le bord du cadre, le 
curseur prend l’aspect d’une main, vous pouvez alors cliquer-glisser pour déplacer le cadre.

Pour supprimer n’importe quel élément :

1) Cliquez sur l’élément, pour le mettre en surbrillance.

2) Appuyez sur la touche Del ou Suppr selon les claviers pour le supprimer.

Ajouter du texte à une diapositive
Pour ajouter du texte à une diapositive qui contient un cadre-texte cliquez sur Cliquez pour ajouter  
un  texte dans  le  cadre  texte  et  saisissez  votre  texte.  Les  styles  hiérarchiques  sont  automa-
tiquement appliqués au texte au fur et à mesure de votre saisie. Vous pouvez changer le niveau 
hiérarchique de chaque paragraphe de même que sa position dans le texte en utilisant les flèches 
de la barre d’outils Formatage du texte (voir la vue Plan page 10). Pour plus d’informations sur le 
texte, voir la section Ajouter et formater du texte page 20.
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Ajouter des images ou des objets à une diapositive
Pour  ajouter  une  image  ou  un  objet,  par  exemple  une  image,  un  clipart,  un  dessin,  une 
photographie  ou  un  tableau,  cliquez  sur  Insertion puis  sélectionnez  dans  le  menu  le  type 
d’élément que vous souhaitez insérer. Pour plus d’information, voir la section Ajouter des images,
tableaux, diagrammes et vidéos page 24.

Modifier l’apparence de toutes les diapositives
Pour  changer  l’arrière-plan  et  d’autres  caractéristiques  de  toutes  les  diapositives  de  la 
présentation, vous devez modifier la page maîtresse ou choisir une autre page maîtresse comme 
expliqué à la section Travailler avec les pages maîtresses et les styles page 27.

Une  page  maîtresse est  une  diapositive  avec  un  jeu  de  caractéristiques  spécifiques  qui  agit 
comme un modèle et est utilisée comme point de départ pour la création d’autres diapositives. Ces 
caractéristiques sont l’arrière-plan, les objets de l’arrière-plan, le formatage du texte au travers des 
styles et les graphiques d’arrière-plan.

Note

On  parle  en  anglais  de  Master  slide,  master  page,  ou  encore  slide  master, 
LibreOffice dans sa version française utilise les termes page maîtresse et Masque 
des diapos. Tous ces termes se réfèrent à une diapositive que l’on utilise comme 
modèle pour  en créer  d’autres.  Ce chapitre  utilise le  terme  page maîtresse ou 
masque suivant le contexte.

Impress propose  une  série  de  pages  maîtresses  qui  se  trouvent  dans  le  panneau  pages 
maîtresses du  volet  Tâches.  Vous  pouvez  créer  et  enregistrer  des  pages  maîtresses 
supplémentaires ou en ajouter de nouvelles à partir d’autres sources. Voir Chapitre 2 Utiliser les  
pages maîtresses, styles et modèles du Guide Impress pour toutes les informations concernant la 
création et modification des pages maîtresses.

Si vous avez simplement besoin de changer l’arrière-plan, utilisez ce raccourci :

1) Sélectionnez Format > Page et allez sur l’onglet arrière-plan.

2) Définissez les propriétés de votre arrière-plan, parmi couleur, dégradé, hachure, bitmap.

3) Validez votre choix.

Une  boîte  de  dialogue  vous  demande  alors  si  cet  arrière-plan  doit  s’appliquer  à  toutes  les 
diapositives. Si vous confirmez, Impress modifie automatiquement la page maîtresse pour vous.

Note

Insérer  et  formater  correctement  un  arrière-plan  va  au-delà  des  objectifs  de  ce 
chapitre,  mais  vous trouverez  toutes  les  informations  dont  vous avez besoin au 
Chapitre 4 Modifier les attributs d’objets du Guide Draw ou au Chapitre 6 Formater  
des objets graphiques du Guide Impress.

Modifier le diaporama
Par défaut, la présentation affichera toutes les diapositives dans l’ordre où elles apparaissent dans 
la Trieuse de diapositives, sans transition entre les diapos, et vous devrez interagir avec le clavier 
ou la souris pour faire avancer le diaporama.

Vous pouvez utiliser le menu Diaporama pour changer l’ordre des diapositives, choisir celles qui 
apparaîtront, déterminer le rythme des transitions automatiques et d’autres réglages. Pour changer 
la transition, les animations, ajouter des sons et d’autres artifices à la présentation, vous devez 
utiliser les fonctions du volet  Tâches. Voir le  Guide Impress pour plus détails sur l’utilisation de 
toutes ces commandes.
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Animer une diapo
Outre les transitions entre les diapos (présentées page 32), il est possible d’animer les objets au 
sein d’une diapositive. Dans la vue Normal, sélectionnez le panneau Animation personnalisée du 
volet Tâches. Pour appliquer une animation, procédez comme suit :

• Sélectionnez l’objet à animer.

• Dans le panneau Animation personnalisée, cliquez sur le bouton Ajouter.

• Sélectionnez le type d’animation à appliquer avec les onglets :

• Entrée : pour faire apparaître l’objet.

• Accentuation : pour mettre en évidence l’objet.

• Quitter : pour faire disparaître l’objet.

• Trajectoires : pour déplacer l’objet.

• Effet divers : pour les objets media (son ou vidéo).

• Dans la liste, sélectionnez l’effet.  Si vous avez coché la case  Aperçu automatique,  après 
chaque sélection, l’animation de l’objet est présentée rapidement.

• Sélectionnez la vitesse d’exécution de l’effet.

• Validez par OK.

Vous pouvez ensuite affiner les réglages de l’effet en modifiant :

• Le déclenchement de l’effet : soit un clic, soit automatiquement.

• Les options supplémentaires propres à l’effet (direction, vitesse, etc.).

Un bouton avec trois points permet d’accéder aux réglages les plus fins de l’effet.

La  liste  des  effets  d’animation  apparaît  en  dessous  avec  les  boutons  flèches  permettant  de 
changer l’ordre.

Attention Bien qu’attrayants,  les  effets  d’animation  utilisés  en  trop  grand  nombre  peuvent 
nuire à l’attention portée par votre auditoire au contenu même de votre présentation. 
Apprenez à les utiliser avec justesse. 

Ajouter et formater du texte

La plupart de vos diapositives contiendront du texte. Cette section vos donnera les méthodes pour 
ajouter un texte et en modifier son apparence. Le texte d’une diapositive est saisi dans un cadre-
texte. Pour plus d’informations sur ce sujet, voir Chapitre 3 Ajouter et formater un texte du Guide 
Impress.

Vous pouvez ajouter deux types de cadre-texte dans une diapositive :

• Choisissez une mise en page prédéfinie à partir du panneau Mises en page du volet Tâches. 
Saisissez votre texte dans l’un de ces cadres au lieu de choisir un contenu spécial. Ces cadres 
deviennent des cadres-texte de Mise en page automatique 

• Créez un cadre-texte grâce au bouton des barres d’outils Dessin ou Texte.

Utiliser les cadres-texte de Mise en page automatique
Vérifiez que vous vous trouvez dans la vue Normal :

1) Cliquez dans le cadre-texte sur la partie supérieure où s’affiche « Cliquez pour ajouter un 
texte ».
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2) Saisissez ou collez votre texte.

Utiliser des cadres-texte via l’outil Texte
Vérifiez que vous vous trouvez dans la vue Normal :

1) Cliquez sur l’icône Texte  de la barre d’outils Dessin ou appuyez sur la touche F2. Si 

nécessaire  faites  apparaître  la  barre  d’outils  Dessin via  le  menu  Affichage > Barre 
d’outils > Dessin.

2) Cliquez-glissez pour dessiner le cadre-texte sur la diapositive. Ne vous inquiétez pas à 
propos de la taille verticale et de la position : le cadre-texte s’ajustera au fur à mesure que 
vous ajouterez du texte.

3) Relâchez le bouton de la souris quand vous avez fini. Le curseur apparaît dans le cadre-
texte, vous êtes maintenant en mode édition (bordures hachurées grises cf Figure 17).

4) Saisissez ou collez votre texte dans le cadre.

5) Cliquez en dehors du cadre pour sortir du mode édition.

Vous pouvez redimensionner, déplacer, supprimer un cadre-texte. Pour plus d’informations, voir 
Chapitre 3 Ajouter et formater un texte dans le Guide Impress.

Figure 17 : Créer et éditer un cadre-texte

Redimensionner le texte rapidement

Impress propose deux icônes  sur la barre d’outils Formatage du texte pour augmenter ou 
diminuer la taille de la police du texte sélectionné. L’échelle des valeurs disponibles dépend des 
tailles standard disponibles pour la police en cours.

Coller un texte
Vous pouvez insérer du texte en le copiant à partir d’un autre document et en le  collant dans 
Impress. Toutefois, le texte collé ne correspondra pas à la mise en forme du texte voisin et du texte 
des autres diapositives de la  présentation.  Le plus souvent,  vous voudrez vous assurer de la 
cohérence  des  styles  de  texte  de  la  présentation,  pour  éviter  une  mosaïque  de  styles  de 
paragraphes  différents,  de  polices  différentes.  Il  y  a  plusieurs  moyens  de  vous  assurer  de 
l’homogénéité du texte ; ces méthodes sont expliquées ci-dessous.

Coller du texte sans sa mise en forme
Il est préférable de coller un texte sans mise en forme puis appliquer le formatage plus tard. Pour 
coller sans formatage, appuyez sur Ctrl+Maj+V puis sélectionnez Texte non formaté dans la boîte 
de dialogue qui s’affiche, ou bien cliquez sur le petit triangle noir en regard du symbole Coller sur 

la barre d’outils standard  et sélectionnez Texte non formaté. Le texte non formaté recevra 
la mise en forme du style hiérarchique en vigueur à la position du curseur dans un cadre-texte de 
mise en forme automatique ou celle du style standard dans un cadre-texte normal.
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Mettre en forme le texte collé
Si vous collez du texte dans une zone de mise en forme automatique, vous devez appliquer le 
style approprié à votre texte pour lui donner la même apparence que le reste de la présentation.

1) Collez le texte à l’emplacement désiré. Ne vous inquiétez pas si l’aspect ne convient pas, 
ce sera réglé dans un instant.

2) Sélectionnez le texte que vous venez de coller.

3) Sélectionnez Format > Formatage par défaut dans la barre des menus.

4) Utilisez les quatre flèches dans la  barre d’outils Formatage du texte (voir  Figure 7) pour 
déplacer le texte à la position appropriée et lui donner le style automatique qui convient. 
Les flèches gauches/droites permettent de monter/descendre dans la hiérarchie des styles 
(plan 1, plan 2, plan 3...), les flèches haut/bas permettent de déplacer le paragraphe dans 
la liste.

5) Appliquez le formatage manuel si nécessaire (police de caractères, tabulation, etc.).

Si vous collez le texte dans un cadre-texte, vous pouvez aussi utiliser les styles pour mettre en 
forme le texte rapidement.  Notez que seul  un  style d’image peut  être appliqué dans le  cadre 
(première catégorie de la boite de dialogue des styles) :

1) Collez le texte à l’emplacement désiré.

2) Sélectionnez le texte que vous venez de coller.

3) Sélectionnez le style d’image souhaité.

4) Appliquez le formatage manuel si nécessaire.

Créer des listes à puces et listes numérotées
La procédure pour créer une liste à puces ou numérotée est sensiblement différente en fonction du 
type de cadre utilisé, cependant, l’outil pour gérer les listes et les personnaliser est le même.

Dans  les  cadres  créés  automatiquement  par  application  d’une  mise  en  page  (voir  section 
Sélectionner  une  mise  en  page,  page  16),  que  nous  appellerons  zone  de  mise  en  forme 
automatique,  les styles hiérarchiques disponibles sont par défaut des listes à puces, alors que 
dans les cadres-texte normaux une étape supplémentaire est nécessaire pour créer une liste à 
puces.

Créer des listes dans une zone de mise en forme automatique
Tous les cadres-texte créés dans les zones de mise en forme automatique sont déjà formatés 
comme des listes à puces. La marche à suivre est alors la suivante :

1) À partir du panneau Mises en page du volet  Tâches, choisissez un modèle de diapo qui 
vous convient.

2) Cliquez dans le cadre où s’affiche : Cliquez pour ajouter un texte.

3) Saisissez votre texte, appuyez sur Entrée pour ajouter une nouvelle entrée dans la liste. La 
méthode pour transformer une liste à puces en liste numérotée est expliquée à la section 
Changer l’apparence d’une liste page 23.

Astuce

Appuyez sur Maj + Entrée pour ajouter une nouvelle ligne sans puce ni numéro. La 
nouvelle ligne sera indentée comme la précédente. Pour retirer toutes les puces, 
sélectionnez la  liste  et  cliquez sur  le  bouton  (Dés)activer  les  puces de la  barre 
d’outils Formatage du texte. Si la barre d’outils Formatage du texte n’est pas visible, 
activez la via le menu Affichage > Barre d’outils > Formatage du texte (Figure 7).
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Créer des listes dans les autres cadres
Pour créer une liste dans un cadre-texte normal, suivez les étapes suivantes :

1) Placez le curseur dans le cadre-texte.

2) Cliquez le bouton (Dés)activer les puces  sur la barre d’outils Formatage du texte.

3) Saisissez le texte et appuyez sur Entrée pour commencer une nouvelle ligne à puces.

La liste par défaut est une liste à puces ; la méthode pour changer l’apparence de la liste est 
décrite en page 23.

Ajouter un nouveau niveau hiérarchique
1) Si nécessaire, appuyez sur Entrée pour ajouter une ligne.

2) Appuyez  sur  Tab ou  cliquez  sur  les  flèches  d’indentation   de  la  barre  d’outils 

Formatage du texte. Chaque fois que vous appuyez sur la touche Tab ou le bouton flèche 
à droite, la ligne est indentée au niveau inférieur. En appuyant sur Entrée vous créez une 
nouvelle ligne au même niveau que la ligne précédente. Pour revenir au niveau supérieur, 
appuyez sur Maj+Tab ou cliquez sur le bouton flèche à gauche.

Dans les zones de mise en forme automatique, abaisser ou hausser d’un niveau un élément de la 
liste correspond à appliquer un style hiérarchique différent ; donc le second niveau d’indentation 
correspond au style  Plan 2, le troisième au style  Plan 3 et ainsi de suite. En conséquence, une 
modification  de  niveau  hiérarchique  produit  un  changement  de  style  (taille  de  police,  puce 
différente...) paramétrable dans le masque de diapositive.

Note
N’essayez pas de changer de niveau en sélectionnant le texte puis en cliquant sur le 
style  comme  vous  auriez  appliqué  un  style  avec  Writer.  Le  fonctionnement 
intrinsèque des styles de présentation empêche de procéder de la sorte.

Changer l’apparence d’une liste
Vous  pouvez  complètement  personnaliser  l’apparence  d’une  liste,  en  changer  les  puces,  la 
numérotation pour la liste entière ou une simple entrée. Toutes les modifications sont accessibles 
via la boîte de dialogue Puce et numérotation, à laquelle vous accédez via le menu Format > 
Puces et numérotation ou en cliquant sur l’icône  Puces et numérotation de la barre d’outils 
Formatage du texte.

Pour la liste entière :

1) Sélectionnez la liste dans sa totalité ou cliquez sur la bordure grise du cadre (de manière à 
ce que les poignées colorées apparaissent).

2) Sélectionnez  Format  >  Puces  et  numérotation ou  cliquez  sur  l’icône  Puces  et 
numérotation  de la barre d’outils Formatage du texte.

3) La boîte de dialogue Puces et numérotation (Figure 18) contient cinq onglets : Puces, Type 
de numérotation, Image, Position, Personnaliser.

• Si  vous  avez  besoin  d’une  liste  à  puces,  choisissez  son  apparence  parmi  les 
exemples disponibles dans l’onglet Puces.

• Si vous avez besoin d’un effet graphique, choisissez parmi ceux disponibles dans 
l’onglet Images.

• Si vous avez besoin d’une liste numérotée,  choisissez parmi les propositions de 
l’onglet Numérotation.
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Figure 18 : Fenêtre Puces et numérotation

Pour obtenir une puce différente dans la liste, cliquez n’importe-où sur cette ligne pour positionner 
le curseur dessus, puis suivez les étapes 2 et 3 des instructions précédentes.

Si la liste se trouve dans un cadre de mise en forme automatique, alors une alternative pour 
modifier la liste entière consiste à modifier le style hiérarchique. L’avantage de cette méthode, c’est 
que les modifications sur le style s’appliqueront à toutes les diapositives qui utilisent ce style, 
permettant de maintenir l’homogénéité de la présentation.

Astuce
Pour assurer l’homogénéité de votre présentation, créez vos styles personnalisés. 
Une fois créés, il suffira d’appliquer les styles pour retrouver une mise en forme 
identique sur toutes vos diapos.

Ajouter des images, tableaux, diagrammes et vidéos

Comme nous l’avons montré sur la Figure 16 page 18, un cadre-objet peut abriter non seulement 
un texte mais aussi une image, un tableau,  un diagramme, une séquence vidéo.  Nous allons 
maintenant vous donner un aperçu rapide des méthodes de manipulation de ces objets.  Vous 
trouverez des descriptions plus détaillées dans le Guide Impress.

Ajouter des images
Pour ajouter une image à un cadre-objet :

• Allez sur  Insertion > Image de la barre de menus principale puis sélectionnez soit  À partir 
d’un fichier soit Scanner.

• Une alternative consiste à cliquer sur l’icône d’insertion d’image du cadre (Figure 16) puis 
sélectionner le fichier dans la  boîte de dialogue  Insérer une image qui s’ouvre. Pour voir un 
aperçu de l’image, cochez Aperçu dans la partie inférieure gauche de la fenêtre.

• Déplacez l’image à la position souhaitée.

L’image sera redimensionnée automatiquement pour remplir l’espace du cadre. Suivez les conseils 
ci-dessous quand vous redimensionnez une image.
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Attention

Pour  redimensionner  une  image,  cliquez  dessus  avec  le  bouton  de  droite. 
Sélectionnez Position et taille dans le menu contextuel et assurez-vous que l’option 
Proportionnel est activée. Ensuite ajustez la valeur du champ Largeur ou Hauteur à 
votre  besoin  (en  modifiant  une  valeur,  l’autre  est  automatiquement  modifiée  en 
proportion). Sans cette précaution, votre image risque de subir des distorsions. Vous 
pouvez également  redimensionner  l’image par  cliquer-glisser  sur  les  poignées en 
maintenant la touche Maj enfoncée pour conserver la proportion entre la hauteur et la 
largeur.

Ajouter des tableaux
Pour afficher des données sous forme de tableau, vous pouvez insérer des tableaux dans une 
diapositive simplement en choisissant l’icône Insérer un tableau comme type de contenu pour le 
cadre. Vous pouvez également dans certains cas ajouter un tableau en dehors d’un cadre-objet.

• Menu Insertion > Tableau de la barre des menus.

• Cliquez sur l’icône Tableau  sur la barre d’outils principale ou sur la barre d’outils Tableau.

• Dans une zone de mise en forme automatique, cliquez sur l’icône Insérer un tableau (Figure
16).

Après avoir choisi l’une des méthodes précédentes, sélectionnez parmi les Styles dans le panneau 
Ébauche de tableau du volet  Tâches.  Une alternative consiste à cliquer sur l’icône  Ébauche de 
tableau  de la  barre d’outils  Tableau pour  ouvrir  le  panneau  Ébauche de tableau du volet 

Tâches.

Les méthodes proposées affichent la boîte de dialogue  Insérer un tableau (Figure 19) où vous 
pouvez définir le nombre de colonnes et de lignes dont vous avez besoin. Vous pouvez également 
cliquer sur la flèche noire en regard de l’icône Tableau, une grille s’affiche alors qui vous permet de 
choisir le nombre de colonnes et de lignes de votre tableau.

Figure 19 : Créer un tableau

Astuce
Choisir un style de tableau lorsqu’aucun tableau n’est sélectionné, ouvre la boîte de 
dialogue  Insérer un tableau. Choisissez le nombre de lignes et de colonnes et un 
nouveau tableau apparaît. Vous pouvez toujours changer de style par la suite.

Lorsqu’un tableau est  sélectionné,  la  barre d’outils  Tableau doit  s’afficher  sinon vous la  faites 
apparaître via le menu Affichage > Barre d’outils > Tableau. La barre d’outils Tableau offre les 
mêmes icônes que celles de Writer, à l’exception des fonctions Tri et Somme. Pour réaliser des 
calculs et des tris, vous devrez insérer une feuille de calcul depuis Calc.

Après avoir créé votre tableau, vous pouvez le modifier à votre guise, comme vous le feriez avec 
un tableau dans Writer (ajouter ou supprimer des lignes ou des colonnes, ajuster la largeur ou 
l’écart, dessiner des bordures, couleurs de fonds, et ainsi de suite). Des informations détaillées 
pour travailler avec les tableaux et leurs propriétés se trouvent au Chapitre 3 Ajouter et formater  
du texte du Guide Impress et au Chapitre 9 Travailler avec des tableaux du Guide Writer.
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Vous pouvez modifier rapidement et automatiquement l’aspect de votre tableau en travaillant dans 
le  panneau  Ébauche  de  tableau du  volet  Tâches.  Globalement  les  Styles vous  permettent 
d’appliquer un modèle de couleurs aux cellules. La section  Afficher proposent des options vous 
permettant  de mettre en évidence la  dernière ligne,  la  première ou la  dernière colonne (vous 
choisissez finalement comment les couleurs se repartissent dans votre tableau).

Après  avoir  défini  l’aspect  de  votre  tableau,  vous  entrerez  les  données  dans  les  cellules. 
L’opération est similaire à entrer du texte dans un cadre. Cliquez dans une cellule pour insérer les 
données et saisissez-les. Pour vous déplacer entre les cellules, utilisez les touches suivantes :

• Les  touches de déplacement (les flèches) déplacent le curseur dans la cellule suivante si la 
cellule est vide, sinon le curseur se déplace sur le prochain caractère dans la cellule.

• La  touche  Tabulation vous  déplace  dans  la  cellule  suivante  quel  que  soit  le  contenu  des 
cellules ; Maj+Tab vous déplace en sens inverse.

Ajouter des diagrammes
Pour insérer un diagramme dans une diapositive vous pouvez :

• soit utiliser le menu Insertion > Diagramme, 

• soit cliquer sur l’icône Diagramme  de la barre d’outils principale, 

• soit (dans une zone de mise en forme automatique) cliquer sur l’icône Insérer un diagramme 
au centre du cadre (Figure 16). 

Impress affiche un diagramme par  défaut  dans la  fenêtre  contextuelle  des  diagrammes.  Pour 
modifier le type de diagramme, saisir vos propres données et changer la mise en forme, référez-
vous au Guide Impress.

Ajouter des fichiers multimédias
Vous pouvez insérer différents types de fichiers multimédia, comme du son ou de la vidéo dans 
votre diapositive, en sélectionnant l’icône Insérer une vidéo (Figure 16) d’une zone de mise en 
forme automatique. Un lecteur de média s’affiche dans la partie inférieure gauche de la fenêtre à 
partir  duquel  vous pouvez lire  le  fichier.  Quand vous ajoutez  un fichier  audio  un haut-parleur 
apparaît dans le cadre-objet. Pour qu’un son soit lu au moment de l’affichage d’une diapo, le son 
doit être défini dans la transition.

Ajouter des dessins, feuilles de calculs et autres objets
Les dessins comme des formes, des légendes, des flèches sont souvent utiles en complément au 
texte d’une diapositive. Vous manipulerez ces objets de la même façon que les dessins avec Draw. 
Pour  plus  d’informations,  voir  Chapitre  7  Débuter  avec  Draw dans  le  Guide  du  débutant,  ou 
Chapitre 4, 5 et 6 du Guide Impress.

Les feuilles de calcul imbriquées dans Impress incluent la plupart des fonctionnalités des feuilles 
de calcul du logiciel  Calc et sont donc capables de réaliser des calculs et analyses de données 
élaborés. Si vous avez besoin d’analyser vos données ou d’effectuer des formules de calculs, ces 
opérations sont plus aisées à réaliser avec Calc. Puis vous pourrez afficher le résultat dans une 
feuille de calcul imbriquée dans Impress ou même mieux dans un tableau natif Impress.

Choisissez Insertion > Objet > Objet OLE > Classeur LibreOffice depuis la barre des menus. 
Par défaut cela ouvre une feuille de calcul au milieu de la diapositive et  les menus et barres 
d’outils deviennent ceux du logiciel Calc. De manière à ce que vous puissiez saisir vos données, 
vous aurez probablement besoin de redimensionner la zone de la feuille de calcul visible. Vous 
pouvez également  insérer  une feuille  de calcul  existante  et  utiliser  la  zone de sélection  pour 
délimiter les données que vous souhaitez afficher dans votre diapositive.
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Impress  vous  permet  d’insérer  une  grande  variété  d’objets  comme un  document  Writer,  des 
formules Math, et même une autre présentation. Pour les détails sur l’utilisation de ces objets, 
reportez-vous au Chapitre 7 Inclure des feuilles de calcul, diagrammes, et autres objets du Guide 
Impress.

Travailler avec les pages maîtresses et les styles

Une page maîtresse est une diapositive utilisée comme point de départ pour la création d’autres 
diapositives. Équivalente aux styles de page de Writer, elle détermine le formatage de base de 
toutes les diapositives basées dessus. Un diaporama peut utiliser plusieurs pages maîtresses.

Note
Nous  nous  attachons  dans  ce  manuel  à  reprendre  les  termes  utilisés  par 
l’application  elle-même.  Nous  utilisons  par  défaut  le  terme  page  maîtresse ou 
masque de diapo ou style de diapo comme l’application elle-même.

Une page maîtresse dispose d’un ensemble défini de caractéristiques, dont un arrière-plan, des 
dessins, des objets (logos, lignes décoratives) en arrière-plan, un en-tête, un pied de page, la 
position et la taille des cadres de texte et le formatage du texte.

Styles
Toutes les caractéristiques d’une page maîtresse sont contrôlées par les styles. Les styles d’une 
nouvelle diapositive sont hérités de la page maîtresse à partir de laquelle elle a été créée. En 
d’autres mots, les styles de la page maîtresse sont disponibles et appliqués dans chaque nouvelle 
diapositive qui utilise cette page maîtresse. Modifier un style dans une page maîtresse modifie 
toutes  les  diapositives  basée  sur  cette  page  maîtresse ;  vous  pouvez  évidemment  modifier 
individuellement  une  diapositive  sans  modifier  la  page  maîtresse,  mais  vous  perdrez  alors 
l’homogénéité de votre présentation.

Note

Par conséquent il  est recommandé d’utiliser la page maîtresse à chaque fois que 
c’est  possible.  Cependant  à certaines occasions il  est  nécessaire d’effectuer des 
changements manuels dans une diapositive en particulier. Si la même mise en forme 
doit  être  utilisée  ultérieurement,  il  vaut  mieux  alors  créer  une  nouvelle  page 
maîtresse.

Les pages maîtresses mettent en œuvre deux types de styles : les styles de présentation et les 
styles d’images. Vous pouvez modifier les styles de présentation pré-conçus mais vous ne pouvez 
pas en créer. Vous pouvez modifier les styles d’images pré-conçus et en créer de nouveaux.

Les styles de présentation affectent  trois  éléments d’une page maîtresse :  l’arrière-plan,  les 
objets d’arrière-plan (tels que les icônes, lignes décoratives, cadre texte), et le texte placé sur la 
diapositive. Les styles de texte se répartissent en Notes,  Plan 1 à Plan 9, Titre et Sous-titre. Les 
styles Plan s’appliquent aux différents niveaux hiérarchiques du plan.

Les styles d’images affectent de nombreux éléments d’une diapositive. Notez que des styles de 
texte existent dans les deux sections styles de présentation et styles d’images.

Page maîtresse
Impress  offre  une  collection  de  pages  maîtresses  qui  apparaissent  dans  le  panneau  Pages 
maîtresses du volet Tâches (Figure 20). Le panneau se divise en trois sections :  Utilisées dans 
cette présentation, Récemment utilisées, Disponibles pour l’utilisation. Vous pouvez développer ou 
réduire les sections en cliquant sur les symboles + ou – à gauche du nom de la section.

Travailler avec les pages maîtresses et les styles 27



Chaque page maîtresse accessible dans  Disponibles pour l’utilisation est  issu d’un modèle du 
même nom. Si  vous avez créé vos propres modèles ou ajoutés des modèles depuis  d’autres 
sources  (par  exemple  des  extensions),  les  pages  maîtresses  de  ces  modèles  apparaîtront 
également dans cette liste.

Créer un masque/une page maîtresse
Pour commencer, activez l’édition des masques en sélectionnant Affichage > Masque > Masque 
des diapos et la barre d’outils Mode masque apparaît. Vous pouvez aussi appliquer un clic-droit 
sur la vignette du masque à partir du volet  Tâches et choisir  Éditer le masque dans le menu 
contextuel. Sur la barre d’outils Mode Masque, cliquez l’icône Nouveau masque (Figure 21).

Figure 21 : Barre d’outils Mode Masque

Un second  masque  apparaît,  dans  le  volet  Diapos.  Modifiez  ce  masque  en  fonction  de  vos 
besoins. Pensez à renommer ce masque : clic-droit sur la vignette du nouveau masque dans le 
volet  Diapos et choisissez  Renommer le masque dans le menu contextuel. Quand vous avez 
terminé, quittez l’édition du masque en cliquant sur le bouton Fermer le mode Masque (Figure 21).

Appliquer une page maîtresse
Depuis  le  volet  Tâches,  affichez  le  panneau  Pages  maîtresses (Figure  20).  Les  nouveaux 
masques apparaissent dans les pages maîtresses.

Pour appliquer une page maîtresse à toutes les diapositives de votre présentation, cliquez dessus 
dans la liste.

Pour appliquer une page maîtresse différente à une ou plusieurs diapositives sélectionnées :

1) Dans le volet  Diapos ou la vue Trieuse de diapositives, sélectionnez les diapositives que 
vous voulez modifier.
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2) Dans le volet Tâches, cliquez-droit sur la page maîtresse que vous voulez appliquer (aux 
diapositives  sélectionnées)  puis  choisissez  Appliquer  aux diapositives  sélectionnées 
dans le menu contextuel.

Charger des pages maîtresses supplémentaires
Parfois,  dans  le  même  diaporama  vous  aurez  besoin  d’utiliser  différentes  pages  maîtresses 
appartenant à plusieurs modèles. Par exemple, vous pourriez avoir besoin d’une page maîtresse 
complètement  différente  pour  la  première  diapositive  de  votre  présentation,  ou  encore  vous 
souhaiteriez ajouter  à votre présentation une diapositive appartenant  à une autre présentation 
(basée sur un modèle disponible sur votre disque-dur). La fenêtre Style de Diapo (Figure 22) rend 
cela possible. Accédez à cette fenêtre soit par le menu Format > Conception de diapo soit par le 
menu contextuel qui apparaît quand vous cliquez-droit sur une vignette de diapositive du volet 
Diapos.

Figure 22 : Style de diapo

La zone principale de la boîte de dialogue montre les pages maîtresses déjà disponibles. Pour en 
ajouter d’autres :

1) Cliquez sur le bouton Charger.

2) Sélectionnez dans la nouvelle boîte de dialogue (Charger un style de présentation Figure
23) le modèle à partir duquel charger la page maîtresse puis cliquez sur OK.

3) Cliquez une seconde fois sur OK pour fermer la fenêtre Style de diapo.

Les pages maîtresses du modèle que vous avez sélectionné sont maintenant disponibles dans le 
panneau Pages maîtresses du volet Tâches, dans la section Disponibles pour l’utilisation.

Figure 23 : Fenêtre Charger un style de diapo
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Note

Les  pages  maîtresses  que  vous  avez  chargées  seront  aussi  disponibles  la 
prochaine fois que vous utiliserez votre présentation. Si vous voulez supprimer les 
pages maîtresses inutilisées,  cliquez sur  l’option correspondante dans la fenêtre 
Style de diapo (Figure 22). Les pages maîtresses qui ne sont pas utilisées dans la 
présentation sont alors enlevées de la liste Disponibles pour l’utilisation.

Astuce
Pour  limiter  la  taille  du  fichier  de  votre  présentation,  vous  devrez  minimiser  le 
nombre de pages maîtresses utilisées.

Modifier une page maîtresse
Sur une page maîtresse, vous pouvez modifier les points suivants :

• Arrière-plan (couleur, dégradé, hachure, image)

• Objets d’arrière-plan (ajouter un logo ou un dessin décoratif)

• Taille, position et contenu des en-tête et pied de page qui apparaîtront sur chaque diapo.

• Taille et position des cadres par défaut pour les zones de titre et de contenu.

Avant de travailler sur une page maîtresse assurez-vous que la fenêtre  Styles et formatage est 
ouverte (touche F11).

Pour sélectionner la page maîtresse à modifier :

1) Sélectionnez Affichage > Masque > Masque des diapos à partir de la barre des menus. 
Cela déverrouille les propriétés de la page maîtresse afin que vous puissiez les éditer.

2) Cliquez sur le panneau  Pages maîtresses dans le volet  Tâches. Ceci vous donne accès 
aux pages maîtresses.

3) Cliquez  sur  la  page  maîtresse  que  vous  souhaitez  modifier  parmi  celles  qui  sont 
disponibles (Figure 20).

La page maîtresse est alors disponible parmi les masques dans le volet Diapos. Vous pouvez alors 
sélectionner le masque que vous souhaitez modifier en le sélectionnant dans le volet Diapos.

Faites vos modifications, puis cliquez sur l’icône  Fermer le mode masque  de la barre d’outils 
Mode Masque.  Pour  plus  de  détails,  voir  Chapitre  2  Utiliser  des  Pages Maîtresses,  Styles  et  
Modèles du Guide Impress.

Attention

Toute modification faite sur une diapositive en mode Masque de Diapos impactera 
toutes les diapositives qui utilisent la même page maîtresse. Prenez soin de toujours 
fermer le mode Masque de Diapos et de revenir en mode Normal avant de travailler 
sur  une  diapositive  quelconque  de  la  présentation.  Sélectionner  Affichage  > 
Normal depuis la barre des menus, ou cliquer sur Fermer le mode Masque de la 
barre d’outils Mode Masque.

Les changements affectés à une diapositive en mode Normal (par exemple, modifier le style des 
puces d’une liste, la couleur de la zone de titre...) ne seront pas altérés par des modifications 
contradictoires  sur  la  page  maîtresse.  Cependant  vous  pouvez  annuler  les  modifications 
manuelles apportées à un objet pour revenir au style défini par la page maîtresse. Sélectionnez 
l’élément puis choisissez Format > Formatage par défaut dans la barre des menus.

Utiliser la page maîtresse pour ajouter un texte à toutes les diapositives
Certaines pages maîtresses présentent du texte en pied de page. Vous pouvez ajouter du texte à 
la page maîtresse pour qu’il agisse comme en-tête ou pied de page de vos diapos.

1) Choisissez Affichage > Masque > Masques des Diapos depuis la barre des menus.
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2) Sur la barre d’outils Dessin, cliquez le bouton Texte ou bien appuyez sur la touche F2.

3) Cliquez-glissez dans votre page maîtresse pour dessiner le cadre-texte, saisissez ou collez 
votre texte à l’intérieur ou ajoutez des champs comme indiqué ci-dessous.

4) N’oubliez pas : Affichage > Normal dès que vous avez terminé.

Pour  insérer  les  numéros  de  pages  (diapos),  la  date  ou  l’heure  au  pied  de  page  de  votre 
présentation, sélectionnez Insertion > Numéro de page ou Insertion > Date et heure pour ouvrir 
la fenêtre En-tête et pied de page (Figure 24) à partir de laquelle vous pouvez sélectionner et 
configurer ces zones de vos diapos.

Figure 24 : Configurer le pied de page des diapositives

Pour insérer un champ tel que la date ou le numéro de page, à l’intérieur d’un cadre ou en tant 
qu’objet séparé, sélectionnez Insertion > Champs puis choisissez le champ requis dans le sous-
menu. Pour éditer ce champ dans votre diapositive, et pour plus d’information, voir  Chapitre 3,  
Ajouter et formater le texte du Guide Impress.

Les champs que vous pouvez utiliser dans Impress sont :

• Date (fixe)

• Date (variable) : mise à jour automatiquement quand vous ouvrez le fichier.

• Heure (fixe)

• Heure (variable) : mise à jour automatiquement quand vous ouvrez le fichier.

• Auteur : nom et prénom renseignés dans les données utilisateur LibreOffice.

• Numéro et/ou nombre de pages (numéro et/ou nombre de diapos).

• Nom de fichier.

Astuce

Pour changer le format du champ numéro de page (1,2,3 ou a,b,c ou i,ii,iii  etc.) 
faites Format > Page, onglet Page, puis sélectionnez le format désiré à partir de la 
liste dans la zone Paramètres de mise en page.

Pour modifier le style du paragraphe, intervenez sur le style de présentation Objets 
d’arrière-plan.
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Astuce
Pour modifier les informations sur l’auteur, allez à Outils > Options > LibreOffice > 
Données d’identité.

Paramétrer le diaporama

Comme mentionné au paragraphe  Modifier  le  diaporama de  la  page  19,  Impress  affecte  des 
paramètres par défaut raisonnables, mais vous autorise à personnaliser de nombreux aspects de 
votre  diaporama.  Cette  section  ne  couvre  que  quelques-uns  des  réglages  possibles ;  les 
techniques avancées sont expliquées au Chapitre 9 Diaporama du Guide Impress.

La  plupart  des  tâches  se  feront  en  mode  trieuse  de  diaporama  où  vous  pourrez  visualiser 
l’ensemble des diapositives simultanément. Choisissez  Affichage > Trieuse de Diapos dans la 
barre des menus ou cliquez sur l’onglet Trieuse de Diapositives en haut de l’espace de travail.

Transitions entre diapositives
Une  transition  de  diapositive  est  l’animation  jouée  lors  du  changement  de  diapositives  de  la 
présentation. Vous pouvez configurer la transition à partir du panneau Transition du volet Tâches. 
Sélectionnez la transition souhaitée, la vitesse de l’animation, choisissez si vous souhaitez passer 
à  la  diapo  suivante  sur  un  clic  de  l’utilisateur  ou  si  le  déclenchement  est  automatique  et 
chronométré. Cliquez sur Appliquer à toutes les diapos, à moins que vous ne préfériez varier les 
transitions au long de la présentation.

Astuce
Le panneau Transition propose une option très utile :  Aperçu automatique. Cochez 
l’option  et  à  chaque  changement  de  transition,  la  diapositive  apparaîtra  dans 
l’espace de travail avec le nouvel effet de transition.

Déroulement automatique des diapositives
Vous pouvez régler la présentation pour passer automatiquement à la diapositive suivante après 
un délai de temps à définir dans le panneau Transition du volet Tâches. Allez à la section Passer à 
la diapo suivante et sélectionnez Automatiquement après, ensuite définissez en secondes, le 
délai d’affichage de chaque diapositive. Cliquez sur le bouton Appliquer à toutes les diapos pour 
appliquer les mêmes paramètres à toutes les diapositives.

Note
Le déroulement automatique d’un diaporama sera bloqué si vous avez paramétré 
des effets d’animation se déclenchant au clic (voir Animer une diapo page 20).

Astuce
Pour recommencer un diaporama après l’affichage de la dernière diapositive, aller 
sur Diaporama > Paramètres du diaporama. Sélectionnez Auto pour le type et le 
délai de pause entre diaporamas. Cliquer OK quand vous avez terminé.

Un jeu de diapositives – plusieurs présentations
Souvent vous penserez avoir trop de diapositives pour le temps imparti à votre présentation, ou 
bien vous souhaiterez faire un rapide tour d’horizon avant d’entrer dans les détails.  Plutôt que 
d’avoir à créer une nouvelle présentation, vous pouvez utiliser deux outils fournis par Impress : 
masquer une diapositive et personnaliser votre diaporama.
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Pour masquer une diapositive, sélectionnez-la dans le volet Diapos et cliquez sur l’icône du milieu 
lorsque la souris survole cette diapo (Figure 2). Les diapositives masquées sont marquées par des 
hachures grises.

Pour réorganiser votre présentation, choisissez Diaporama > Diaporama personnalisé. Cliquez 
sur le bouton Nouveau pour créer une nouvelle séquence de diapositives et sauvegardez-la. Vous 
pouvez créer autant de diaporamas que vous souhaitez à partir d'un même jeu de diapositives.

Jouer un diaporama

Pour jouer un diaporama, choisissez l’une des méthodes suivantes :

• Sélectionnez Diaporama > Diaporama sur la barre des menus.

• Cliquez l’icône  diaporama sur la barre d’outils Présentation.

• Dans le volet Diapos, cliquez sur le bouton le plus à droite (lorsque vous survolez la diapo) de 
la diapo à partir de laquelle vous voulez commencer le diaporama.

• Appuyez sur la touche F5 du clavier.

Si la transition du diaporama est configurée sur Automatiquement après x secondes, laisser le 
diaporama se dérouler de lui-même.

Si la transition est configurée sur Au clic, faites comme suit pour passer à la diapositive suivante :

• Utilisez les touches directionnelles du clavier (flèche droite, flèche gauche) pour passer à la 
diapo suivante ou revenir à la précédente.

• Cliquez avec la souris pour atteindre la diapositive suivante.

• Appuyez sur la touche espace du clavier pour avancer à la diapo suivante.

• Tournez la molette de la souris.

Cliquez-droit n’importe où pour ouvrir un menu contextuel à partir duquel vous pouvez naviguer 
entre les diapositives et régler d’autres options. 

Astuce
Si vous avez beaucoup de diapositives, il sera alors plus aisé de retrouver la diapo 
recherchée si vous lui avez donné un nom.

Pour quitter le diaporama à n’importe quel moment, appuyez sur la touche Échap.
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